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This presentation is largely comprised of techniques I have learned 
through reading and working on the exercises in Dan Margulis’ book 
Photoshop LAB Color: The Canyon Conundrum and Other Adventures in 
the Most Powerful Colorspace.

Due to copyright restrictions, some of the examples presented in 
the CTAPP session cannot be duplicated here since the images used 
were images from the book’s CD-ROM. I have tried to come up with 
substitute images of my own for those cases, and I have provided 
references to the file on the CD-ROM and the chapter in the book as 
appropriate.

I began the CTAPP presentation with a short review of the book. 
Only two people in attendance besides myself had read the book, both 
described it as excellent. This is my assessment as well, however, there are 
a few things you should know before you run out and buy it:

It is a little expensive (list price $54.99), because it is over 360 large 
(8x10) pages, most all in full color. Check your favorite discount 
bookseller for better pricing.

It is rather technical, recommended for those who consider themselves 
reasonably advanced with Photoshop, especially channels. Get used to 
reading lots of numerical channel references.

Most of the techniques are described in Dan’s prose rather than in a 
recipe or tutorial format. You may need to go thru the procedures a few 
times to get them to work for you.

»

»

»

Introduction

Photoshop LAB Color
by Dan Margulis
Peachpit Press, 2006
ISBN 0-321-35678-0
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Scott Kelby is the president of the National Association of Photoshop 
Professionals and the editor of Photoshop User magazine as well as Layers 
magazine. I believe he has recently attained the distinction of being the 
best selling computer book author ever. Most of his books are collections 
of Photoshop tips, tricks and tutorials. It’s a fair assumption that he has 
seen, if not written about, every Photoshop technique known today. Thus, 
for him to call this book on Lab “revolutionary” is quite a statement.

It appears as though he is correct. I attended the MacLive conference 
hosted by Layers magazine held in New York City in May of 2006. I 
attended at least one session by a noted Photoshop author/educator 
(David Cross) who now incorporates the basic Lab technique described 
later in his own color correction routines. In the conference handout 
book, I noticed several others who now use it too. I’ve seen it in Scott 
Kelby’s most recent book on Channels.

And I have to say that I have found the basic technique so simple and so 
reliable at improving the images I shoot with my digital camera, that when 
I upload the pics to my computer, cull out the ones I think I like, the first 
thing I do is open them, convert them to Lab, and run this move. Very 
often that is all I need to do to decide that I really do like that particular 
picture.

It’s that good.

Introduction

Fake sticker on the cover of the book.
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Colorspaces

A colorspace is basically the set (or gamut) of colors 
that a thing can represent. Photoshop supports 3 main 
colorspaces, RGB (for Red Green Blue), CMYK (for 
Cyan Magenta Yellow blacK) and Lab (Lightness, a 
channel, b channel).

Various devices like printers, monitors, scanners etc 
support subsets of certain colorspaces. These are 
described by color profiles.

The Mac OS X Colorsync utility can display information 
about color profiles, including a 3D representation of 
the profile which you can manipulate to view from any 
angle. (There is a somewhat similar utility for Windows 
XP that you can download from the Powertoys section of 
the Microsoft website. Look for the Color Control Panel 
Application). The Mac Colorsync utility includes generic 
profiles for the major colorspaces for our amusement and 
education.

As you can see from these images, the CMYK colorspace 
is generally smaller than the RGB colorspace. This we 
already know because in Photoshop, it’s easy to choose an 
RGB color and get a little warning that it is out of gamut 
in the CMYK space. Plus, if we use proof view with 
CMYK, or convert an image to a CMYK profile, colors 
often shift as Photoshop tries to compensate.

Above, two views of the Generic RGB colorspace 
as seen in Colorsync. Below, the Generic CMYK 
colorspace.
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Colorspaces

The Lab colorspace is, as the British might say, thick 
as a brick. It is vast compared to the RGB space. All 
RGB colors can be represented in the Lab space. There 
are many more colors in Lab. In fact, many colors 
are available mathematically in Lab that are not even 
perceivable by humans. Dan Margulis refers to these as 
imaginary colors.

Remember that our monitors are limited to display 
of RGB colors, so what we see in Colorsync is only an 
approximation of what the color would actually look like 
if we could see it. Photoshop uses Lab internally for its 
calculations, and the display engine converts any out of 
gamut colors to its best approximation. It turns out that 
this approximation is pretty good, and useful, as we’ll see.

Dan Margulis is rumored to be a stickler for 
pronouncing Lab as “ell-ay-bee” rather than 

the word we know as short for laboratory. 
His rationale is allegedly that we don’t say 

“riggib” or “smyke” for RGB or CMYK. I 
try to follow this when speaking, but I often 
slip up. Hey, we all know what we’re talking 

about, right?

Above, the Lab colorspace, as viewed in Colorsync. Below, a representation of the RGB colorspace inside the Lab color-
space.
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Lab numbers  

We’re all familiar with the RGB sliders in the Photoshop 
color palette (I hope!) where 0R0G0B is black, 
255R255G255B is white, pure red is 255R0G0B, yellow 
is 255R255G0B, etc. Greys are represented by all 3 values 
being the same, e.g. a 50% grey is 127R127G127B. These 
numbers run from 0 to 255 because 256 is one of those 
typical computer numbers (8 binary bits can represent 
256 values).

CMYK numbers run from 0% to 100%, white to black, 
because they represent the coverage of ink on a printed 
page.

Lab numbers are a little different. First, the L (Lightness) 
channel represents tonality, i.e. how light or dark the 
image is. It runs from 0 to 100, like a percentage. It’s 
almost like the inverse of the CMYK blacK channel in 
that 0 is black and 100 is white.

The a and b channels are the color information, and they 
have 256 values like RGB channels, except they run from 
negative 128 to positive 127. Negative a values represent 
green, positive are magenta. Negative b values represent 
blue, positive yellow. These 4 colors are all it needs.

Note that a value with 0A0B in it is always a grey. How 
light or dark a grey it is, of course,  controlled by the L 
channel.

To avoid using minus signs in printing Lab numbers, the 
Margulis book uses values in parenthesis like on a ledger 
for negative. Thus 0R255G0B converts to 83L(128)A87B. 

The color palette for RGB and Lab.

Lab slider settings for the pure RGB colors 
red, green, blue, and 50% grey.



�

Lab numbers  Lab curves  

The adjustments we will make in Lab will be done using the curves 
command. The above image shows the 3 Lab channels in separate curves 
with swatches overlaid to illustrate the results of moving the curve. Move 
the L curve towards the upper left and the image becomes lighter; move 
it towards the lower right and it gets darker. This is true regardless of 
what part of the curve you move, that will only determine what range of 
the image goes toward light or dark.

Similarly, moving the a curve towards upper right pushes the image 
towards magenta, moving it towards the lower right moves it toward 
green. Likewise for b, upper left tends to yellow, lower right tends to blue.

Note: in the Margulis book, he orients his curves the opposite of the 
ones I show here. I suspect he’s more experienced with CMYK curves 
and prefers white on the lower left and black on the top and right. My 
curves are oriented like RGB curves. You need to remember to rotate the 
curve plot 180˚ to switch between the two.

To change the grid of the 
curves dialog between 4-

square and 10-square, alt- or 
option-click the grid.

To enlarge the curve dialog, 
click the icon in its lower right 

corner.
To change the orientation of 

the curve, click the double 
triangle indicator at the 

bottom of the grid.
To select a curve point using 
the keyboard, press Ctrl-Tab  
or Shift-Ctrl-Tab (Mac and 

PC). Then you can nudge the 
point around using the arrow 

keys.
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If you’re not familiar with curves, they can pretty much do anything 
levels can do, plus more. Whereas levels can adjust the black and white 
points of an image and make a single contrast adjustment over the entire 
image (using its middle slider), curves will let you adjust the values up or 
down at many points over the entire range. 

When the curve goes straight from the lower left to the upper right at a 
45˚ angle, the image has no adjustment. When you add or move points 
so that part or all of the curve becomes steeper than the default, you are 
increasing contrast over that range of the image. When you make the 
curve flatter than the default, you are reducing contrast.

The beauty of the Lab colorspace is that by definition, tonal contrast is 
separated from color contrast. You adjust the former using the L channel. 
You adjust the latter in the a and b channels. Once you play around 
with this and see it in action, it becomes very intuitive, and extremely 
powerful.

The basic procedure, then, for improving images is simply this:

Convert the image to Lab using Edit -> Convert to 
Profile, then choose Lab Color. Make sure the Engine 
is Adobe (ACE), Intent is Relative Colorimetric, and 
Use Black Point Compensation is selected; deselect Use 
Dither and Flatten Image. You may be prompted again 
to flatten the imatge. For now, try it without flattening. 
If strange things happen you will need to undo the 
conversion and retry it using flattening. Many layer 
features will not convert well without flattening.

Adjust tonal contrast by steepening the L channel. You can do this 
overall by moving the end points in, or adjust the contrast over certain 
ranges of the image by adding points to the curve around the range of 
interest and then steepening the curve using those two new points

Adjust color contrast by moving the end points of the curve for 
both the a and b channels. You will want to move the 2 points the same 
amount, otherwise you will introduce a color cast. Use the grid markings 
to make sure the movement is the same on the top and bottom.

At this point in the presentation I demonstrated this technique using 
a couple of examples from the Margulis book: Chapter_01/Anza-
Borrego_badlands.psd and Chapter_01/Artists_Palette.psd. Both of 
these are desert canyon landcapes. Due to copyright restrictions I cannot 
reproduce them here.

1)

2)

3)

The “Canyon Conundrum” 
in the book title comes from 
the fact that pcitures of 
western U.S. canyons are 
common pictures that people 
take where the camera never 
seems to capture the drama 
that compelled the shooter to 
take the picture in the first 
place. These are the kinds of 
pictures that this procedure 
can greatly improve. Another 
type of picture that it works 
especially well on is  woods 
and fields. Since I haven’t 
been out west lately, I’ll use 
some of my Connecticut woods 
and field pictures.

Moving the black/white end-
points in Levels is like moving 
the endpoints in Curves.
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The above is an example of this technique. The curves were applied to the 
topmost photo to produce the lower image. It has more contrast overall, 
thanks to the L curve, and the greens and yellows stand out more, thanks 
to the a and b curves.

This basic routine is always the first, and often the only, correction I now 
apply to all of my digital images, right after culling the keepers using 
Adobe Bridge.
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Variations on the basic Lab retouch

Using the Shadow/Highlight adjustment: I don’t know about you, but 
I have always had trouble with Shadow/Highlight (in RGB), it always 
seems to do weird things to the colors. But once you realize that it is 
mainly for grayscale images, then it becomes much tamer, and perfect 
for applying to the L channel. You probably want to duplicate the layer 
to apply it, since it can not be applied non-destructively like adjustment 
layers.

Sharpening: Again, this filter works much better when it’s applied 
to the L channel. Many people use Unsharp Mask in RGB, then use 
Edit -> Fade and change to Luminosity mode to avoid affecting color. 
However, if your sharpening happens to form a white highlight halo 
(as may happen over a yellow background), you will find that even the 
Luminosity mode trick won’t avoid the haloing. However, in Lab on the 
L channel, it will. I demonstrated this briefly at the meeting. The issue is 
discussed in the book in Chapter 5, especially beginning on p.95 using 
the yellow_sign_to_sharpen.psd file from the book’s CD-ROM.

At the last Photoshop World I attended (Sept 2005 in Boston) there was 
a session called “Unsharp Mask is Dead”. How can they say that, many 
asked, USM is usually every retouchers final step. The answer is that there 
are two other ways to sharpen that many find superior. One is the new 
Smart Sharpen filter in CS2. That has some extra controls to limit its 
effect on shadows and/or highlights.

The other alternative has been one of my favorites for quite awhile now, 
and I showed a way to utilize it in Lab. This is not in the Margulis book, 
although he does mention the RGB procedure in passing. The basic 
routine is this (skip steps 3 and 4 if you are in RGB mode)

Duplicate the layer; or if you have many layers, do a stamp visible (aka 
the Vulcan Death Grip) hold down the entire left side of your keyboard... 
kidding, hold down Cmd, Option and Shift (PC: Ctrl, Alt and Shift) 
and press the letter E. This will create a new layer with a merged copy of 
everything. It’s like flattening into a new layer while keeping all of your 
original layers underneath. Note that if you have a version prior to CS2 
you must create an empty layer yourself, and have that layer selected 
before you do this.

Change the layer blend mode to Hard Light.

If you are in Lab mode, double click on the layer to the right of the 
layer name to bring up the Blending Options dialog. Under Advanced 
Blending, turn OFF the a and b channel switches, leaving only the L on.

Again assuming Lab mode, switch to the channels palette and select 

1)

2)

3)

4)
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the L channel. You can then click the eyeball on the Lab composite layer 
so that you get the full color preview back.

Run Filter -> Other -> High Pass. Start with about a radius of 10. 
Adjust + or - until the little preview shows a mostly grey image with good 
edge contrast. You should see the actual image become much sharper if 
you have the Preview checkbox checked.

Adjust opacity of this layer to taste. 100% is usually too harshly 
sharpened. 50% or lower usually looks good on the screen; you may want 
it higher for prints.

This is a neat nondesctructive way to sharpen that allows you to change 
the strength of the sharpening later, i.e. even after saving the file. You 
probably still want to do it late in the retouching session since the stamp 
visible freezes your image in the duplicate layer. But since you still have 
all your original layers, it isn’t too hard to delete the stamp visible layer, 
make further changes in the original layer stack, then redo the procedure.

The next page shows an example using all the above variations.

Blur the a and b channels: This can be useful to reduce color noise, 
especially in low light/high sensitivity images. As it turns out the a and 
b channels, despite their apparent limited range, can take an awful lot of 
abuse before they drastically affect your image. A quick demonstration 
of this: take an RGB image, go to the channels palette, select any of the 
channels, do a select all, then use the move tool to shift it 10 or 20 pixels 
down and to the right. Repeat with one of the other channels, but shift it 
in a different direction. Now view the composite. It’s a mess, right? Now 
try the same thing with a Lab image, shifting the a and b channels. There 
is some color shift, but the picture is generally still recognizable.

5)

6)

Left, the original image. Middle, the result of shifting the red channel down and to the left and the 
green channel down and to the right. Right, the result of shifting the a channel down and to the left 
and the b channel down and to the right. The point is you can mess with the a and b channels a lot 
more than you can the RGB channels.
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The original image.

Shadow/Highlight adjustment applied to the L 
channel. The amount and tonal range was turned 
down from the default to make the adjustment 
more subtle, then raising the radius filled in the 
foreground tower shadow nicely.

Curves adjustment layers. I liked the way the 3-square a channel adjustment 
brought out the red of the brickwork, but it made the grass too green. To adjust 
parts of the graph, first lock in the center point to prevent overall color cast. Then 
add points and adjust the part of the curve where you want to adjust color.
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Blurring the a and b channels can be useful for removing color noise from 
low light high sensitivity images. This can be demonstrated by taking an 
RGB file, converting to Lab, blurring the a & b channels, and converting 
back.

This is demonstrated even more dramatically in the 
Margulis book in Chapter 5, using  his Flite_Ops_
Director.psd image.

Original image (RGB)

Below, the red, green and blue channels, respectively. Typical for 
these types of images, the blue channel shows a fair amount of 
noise..

The original image was converted to Lab. Then a Gaussian Blur 
was applied to the a channel (at about a 5 pixel radius) and the b 
channel (at about a 7 pixel radius). Then the image was converted 
back to RGB. The resulting blue channel appears at left. The com-
posite image didn’t look much different; the effect of this on this 
image can only be seen at very high magnification.
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Imaginary Colors  

The Lab colorspace allows for colors that do not exist in the RGB 
colorspace. As a matter of fact, you can call for colors that don’t 
even exist in human perception. For example, a very pure yellow is 
255R255G0B. Convert this to Lab and you get 98L(16)A104B. This 
means two things: First, Lab can produce a color that is even more yellow 
than that by setting the B value to 127. Secondly, it can create a lighter 
yellow by increasing L to 100. This essentially means that the color is 
nearly 20% more yellow than that pure yellow, AND it’s as bright as 
white. It’s generally impossible to imagine such a color, but Lab can call 
for it. So we call these imaginary colors.

What good are they? Well, your first thought is not very much, since we 
can’t display them on our monitors and we certainly can’t print them. But 
the magic lies within Photoshop and its RGB display engine. Where you 
might try to make an adjustment that drives a color to pure white (thus 
rendering it fairly useless), you can make a similar adjustment in Lab and 
it will look like what you want—perhaps a very bright pale yellow—and 
it can carry through a conversion to RGB and even print decently in 
CMYK.

A little experiment shows the power of this. Start with an image with 
blown out highlights. I used a photo taken during a living room concert, 
where a musician plays in someone’s living room for a small (10-25) 
people. They normally don’t mind people taking pictures, or even 
recording, as long as it doesn’t interfere with others enjoyment. Naturally, 
this means no flash.

The picture on the next page is one such picture, and the halogen 
torchieres cause blown out highlights. Wouldn’t it be nice to tone them 
down, maybe to a shade of reddish yellow to match the tone of the rest of 
the picture?



15

Imaginary Colors  

If you convert it back to RGB now without flattening, you 
will get right back to the 4th image. If you want this to 
survive the conversion, you will have to flatten it—that’s 
just how the color blending mode works.

That is also why, in general, you should flatten images 
when you convert between the spaces. Adjustment layers, 
in particular, will practically never convert correctly.

1. Original image, RGB mode. 
The color at the cursor is chosen 
as the foreground color.

2. The blwon out areas are 
selected using the Magic Wand 
with a high threshold (128), 
non-contiguous.

3. A new layer is created and 
filled with the foreground color 
chosen above.

4. The layer is changed to color 
mode to try to make it blend 
better. Oops! The underlying 
white highlights overpower the 
color layer.

5. The image is converted to 
Lab mode without flattening to 
preserve the color layer. What’s 
this? Now the layer, still in color 
blending mode, shows a nice yel-
low that is pretty close to what 
was wanted in the first place.
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Selecting & Changing Colors  

At the meeting, the topic of selectively changing colors appeared to have 
been a popular one. I guess a lot of you wind up with image situations 
where someone or something shows up with the wrong color.

There are many ways to change colors in Photoshop, most of them 
involve making selections of the areas containing the color you want to 
change. You have to be careful with these, since highlighting and shadows 
affect colors, and you usually have to work at the selection to get it all 
convincingly. 

Since Lab separates color from tonal information inherently, you will 
often find that the color areas you are lookiing to isolate are fairly well 
defined regardless of highlighting or shadowing. In very many cases, 
assuming you use layers (adjustment or otherwise), there is a very 
powerful alternative to making selections: you adjust how much of your 
images gets blended in depending on the color.

Let’s start with a rather contrived example. Say you wind up with the 
following photo of a red car. Your client, for whatever reason, cannot use 
a red car in this case. The client needs a green car.
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Selecting & Changing Colors  
Okay... well, let’s try this. Convert the image to Lab. Create a curves 
adjustment layer. Apply the curve shown at right to the a channel. (Drag 
the point on the lower left to the top, then drag the point on the upper 
right to the bottom, thus inverting the curve).

Make sure to point out the all the variations in shades of red and green 
in the images, how difficult it was to get them all right, and charge the 
client accordingly.

Of course this is a highly contrived example. And if you look closely, you 
will see that the original image looks like it was taken in summer, but 
the modified image looks like it was taken in fall: the trees and grass are 
reddish, including the ones reflected in the windshield. Plus, there’s an 
amber turn signal light that has gone green as well.

Rather than running for the quick mask, take advantage of the use of 
the adjustment layer and double click on the layer itself (not the icon, 
not the name, but to the right of that). This brings up the layer blending 
options (it’s actually the layer style dialog box, but the topmost option 
in that dialog is the blending options we want). At the bottom of this 
dialog is the Blend If section. We select the a 
channel and move the green side slider of the 
Underlying layer control over to the middle. 
Then we hold the Option key (PC:Alt) and 
move the right side of the slider over a little to 
soften the transition.

The result is on the next page.
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That does a nice job of changing the background foliage back to summer 
green. It doesn’t help with the amber signal light. In this case, the amber 
is so close to the red of the original that it is virtually impossible to isolate 
this way. Now you can get out your masking tools. Just paint a little black 
on the mask of the curves adjustment layer and that will do it.

This example is very similar to one from the book that I showed during 
the presentation, from Chapter 10, using the image red_car.psd from 
the book’s CD-ROM. Also in that chapter are some more involved 
examples of changing a given color to a very specific color, for instance 
a particular color from the Pantone set. The overall procedure is fairly 
straightforward:

Convert to Lab and determine the equivalent numbers for the target 
color, and also select a spot on the image that best represents that color, 
because highlights or shadows will shift the color reading. For example, 
in the preceding car example, a good spot might be just above the 
headlight nearest us.

Using Lab curve adjustment layers, force that spot to the target color. 
There are cases where this is more difficult than others, i.e. trying to 
drive a value of a = 2 to a=75. This will result in an unmanageable nearly 
vertical curve. There are tricks to get around this, including replacing the 
a channel with a copy of the b! (on a duplicate layer, of course, to preserve 
an original channel copy)

Restore all the collateral damage to the other colors, using mainly the 
Blend If sliders, and layer masks.

There was some interest in demonstrating a more involved version of this 
procedure at a future meeting, or perhaps as a “two minute drill”. Stay 
tuned for future updates.

1)

2)

3)
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A related topic discussed was on using channels as selection masks. The 
ideal here is that for creating selections or layer masks, rather than fussing 
with the lasso tools or the pen or even the marquees or color range 
selections, use the information in your channels to build the mask. Since 
most images start in RGB mode, and you should now want to convert 
them (at least a copy for experimentation) to Lab mode, that means you 
have 7 channels of information to look at to help build your mask. The a 
and b channels of Lab turn out to be particularly valuable since they only 
contain color information (which is often the major identifying factor of 
the object we wish to isolate). Plus, they actually contain 4 colors worth 
of information if we know what to look for.

A mask is a greyscale image that covers the object/area of interest in 
white and all the other areas in black. When we want to isolate magenta 
or yellow objects, we look for areas in the a or b channels that are lighter 
than the rest of the image. When we want to isolate green or blue objects, 
we look for areas that are darker in the a or b channels and then invert 
it to make them the light areas. Since the a and b channels are rather 
constrained in range compared to RGB channels, we need to force 
that range to white and black. This is like what you can do with Image 
-> Adjustment -> Threshold; however a better way is to use Image -> 
Adjustment -> Levels and move the black and white sliders until they 
are almost on top of each other. This automatically gives you a little grey 
transition area between black and white. I refer to this procedure as 
‘choking the mask’ or ‘choking the levels’.

Let’s look at a non-trivial example.

Suppose we want to isolate the flowers 
and the greens from this image so that 
we can put our own background in 
it, perhaps for a greeting card. This is 
probably something that would not be 
a lot of fun to have to do with a lasso or 
pen or quick mask. The color and tone 
variety is wide enough that selecting 
by color is not going to help a lot. Let’s 
start by looking at our channels.
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The blue channel shows some promise for selection the flowers, but 
there’s still a lot of ground noise showing up light in the lower right. Let’s 
convert it to Lab but we’ll do it in a duplicate image, just in case we want 
to use any of these RGB channels later.

The a channel and the b channel both have potential because the flowers 
contrast with the rest of the channel, and they don’t show much ground 
clutter. Let’s try the b channel: we duplicate the channel, Image -> 
Adjustments -> Invert, then Image -> Adjustments -> Levels. Choke the 
mask as shown.

That’s not bad for the flowers. The main thing here is to get the edges, 
the pistils or stamens of the flowers (or whatever they’re called) can be 
painted in easily. It’s the outside edges that are tricky to paint.

If all you want are the flowers, that’s probably all you need to do. But 
suppose we want the greens too. For that we need to work on another 
channel, and combine them later. Let’s try inverting the a and choking it.

Red channel Green channel Blue channel

L channel a channel b channel

b copy inverted and choked
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That’s not bad, it would be nice if we could get the center stems of the 
long leaves, although they too are inside the outline we’re trying to 
achieve, so perhaps its best to just move on. (Hint: you could try going 
back to the RGB copy and duplicating the Blue channel into this Lab 
document, then choking that down to try picking up the stems... but 
you’ll wind up picking up a lot of ground noise in the process. For some 
images and masks, that may be worth doing. But probably not this one).

There are a couple ways to put these masks together. One is, of course, to 
load one as a selection, then load the other as a selection adding to the 
first. But there’s a more flexible and visual way of doing it, by using Apply 
Image.

To set up Apply Image, you must select the target layer and channel that 
you want to combine the channel masks into. For this, just so we have 
something to fall back to in case we need it, we will duplicate one of the 
two channels we just created, the “b copy” channel. We can do this by 
simply dragging “b copy” down to the new channel icon at the bottom 
of the palette. At this point we might want to rename it from the given 
“b copy 2” so we don’t get confused later: rename it to “mask”. Then we 
do an Image -> Apply Image selecting the “a copy” channel as the source, 
mode Lighten:

It’s a good ideal to blur these things before you actually use them, so we 
run a Filter -> Gaussian Blur at a radius of about 3.5. Then we duplicate 
our background layer and insert a layer in between the two. Fill this 
middle layer with grey as our new background. Then load the mask 
channel as a selection and create a layer mask on the top copy.

a copy inverted and choked

after apply image of a copy into b 
copy (aka “mask”) using Lighten 
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No, it’s not perfect as it stands, but this is just a start towards a final mask.
You’d probably want to crop it some, maybe make it square with the 
central bouquet the focal point. Then of course the missing innards need 
to be painted in. But that is much easier than painting the whole thing 
from scratch. And once you get used to what to look for, you can get 
rather decent ballpark masks fairly quickly using these methods.

Left, the image masked using 
channel operations; above, the 
layers palette.
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Portrait Retouching  

Finally, let’s touch on the topic of retouching portraits, a topic covered 
near the end of Dan Margulis’ book. This is one of the rare cases where 
he gives a fairly straightforward recipe, and therefore I’ll go thru it rather 
quickly.

The basic Lab move described early can certainly be used to retouch 
portraits, but this will usually result in a tendency toward color 
saturation which most people don’t find flattering in portraits. Increasing 
color contrast in people’s faces often brings out skin blemishes that 
most people would rather have diminished rather than enhanced. This 
procedure is tailored to increase the overall color contrast, yet in a more 
gentle way, and always allowing complete flexibility by using opacity 
sliders and the like.

This procedure can work 
for any portrait, whether 
it’s professionally lit and 
shot, or just a snapshot. 
For this example I will use 
this picture of yours truly, 
apparently taking the oath 
of office of president of my 
living room, bad lighting, 
cropping, and all.

We start this procedure in 
RGB mode. We’ll convert 
to Lab later, but there is a 
preliminary step we’ll want 
to do in RGB mode.
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First, examine your RGB channels and pick the one the shows the most 
contrast, but without overly darkening certain desirable features, i.e. 
blond hair. In a portrait, this is normally the green channel, and that is 
the channel we will use here.

Now we duplicate the background layer of this RGB image and 
apply the green channel to the new layer, which makes the image 
greyscale momentarily, until we change the blending mode to 
Luminosity (unfortunately Luminosity is not one of the blending 
modes offered in the Apply Image dialog directly). This will 
increase the overall image contrast slightly.

Something to watch out for at this step: if the original image contained 
any very dark reds or purples, this step may make them too intense. Use 
the Blend If sliders for the Green channel, underlying layer to reduce 
them.

Next, convert the image to Lab mode. When it prompts you to flatten 
the image, do not do so. However, once converted, do flatten the image 
yourself, using Layer -> Flatten Image or Merge Down from the Layers 
palette. A very slight additional contrast change results when you do it 
this way (compare them in the history palette).

Red channel Green channel Blue channel

Original After Apply Image of green channel; Luminosity mode.
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Now that we’re in Lab mode, create a duplicate layer here. In this 
duplicate layer, we are going to do two things:

Apply the a channel to itself in Overlay mode

Apply the b channel to itself in Overlay mode

In general, you will be doing these at 100% opacity (in the Apply Image 
dialog), but there are some things to consider:

For caucasian skin tones, you probably want to favor the b channel in 
the weighting of these two steps, since this will give a slight emphasis to 
yellow tones, and that is pretty much accepted as a good skin tone for 
such people: use a at around 70% opacity, b at 100% opacity

For dark skin tones, e.g. those of African descent, you probably want to 
favor the a channel in the mix, since that skin tone looks better tending 
towards magenta than yellow: a at 100%, b at 70 or 80%.

For all the other skin tones between these extremes, you can probably 
go 100% to both.

Here’s what it does to my European Caucasian mug:  

At this point the color is obvioously too intense, but we are on a separate 
layer so we can and will lower the opacity of this layer quite a bit to taste.

Depending on the picture you may want to add a curves adjustment layer 
and apply a slight S-curve to the L channel to enhance overall contrast.

Sharpening can also be done on the L channel at this time, either using 
Unsharp Mask, Smart Sharpen, or the High Pass filter method shown 
earlier.

Before and after are shown on the following page for comparison. I used 
about a 40% opacity on the color modification layer.

1)

2)

»

»

»

After Apply Image of a channel to itself in Overlay mode. After Apply Image of b channel to itself in Overlay mode.
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That’s pretty much it. Whether it has improved this particular image is 
debatable, but trust me, it does do nice things to a good portrait of an 
attractive person.

This also pretty much covers what I talked about at the CTAPP meeting 
of July 17th, 2006. It certainly doesn’t begin to cover all the concepts 
from Dan Margulis’ book Photoshop Lab Color, but it does touch on 
some of the concepts I found easily and immediately useful. I hope it 
helps you in your journey.
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Gallery  

Pittsburgh at Night from West End Park, July 2006
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Good Hill Sunset 4-5-04



29

Metropolitan Museum of Art, 12-5-05



Colophon

The document layout was done in Adobe 
InDesign CS2. The text font is Adobe 
Garamond Premier Pro, and the display 
font is Papyrus.

All Lab images were placed into InDesign 
natively—one of the advantages of working 
within the Adobe suite: you don’t have to 
convert them all to RGB first, as you do 
with, say, Quark XPress.

All images ©2006 Mike Weis (except of 
course the cover of the Photoshop Lab Color 
book and the “sticker” which are included 
here for editorial use only). Reproduction 
prohibited.

email: mikeweis@livegraphicservices.com
http://www.livegraphicservices.com
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